
Mac OS Internet Customer Help Sheet No.21
“Troubleshooting Microsoft Internet Explorer”

This document describes a set procedure for troubleshooting problems and/or crashing/freezing
with Microsoft Internet Explorer (IE) web browser software. So that you have an idea of what you
may be required to do Microsoft recommends reading this entire document before starting.

PART ONE: FIRST CHECKS
Below are some first checks that can be performed. You are advised to check all of the steps in this
part before attempting to open/use Internet Explorer again.

Step 1: COLD BOOT YOUR MAC: Select “Shut Down” from the ‘Special’ menu. When the
screen goes black wait for thirty seconds. Then startup your Macintosh.

Step 2: INTERNAL HARD DISK: Check your hard drive over with the latest copy of Disk First
Aid (this will usually be found in the “Utilities” folder or on your system software
CD/Disk Tools floppy disk). More details on Disk First Aid should be in your manual or
contact Apple on 0990 127753.

Step 3: REBUILD THE DESKTOP: Restart your Macintosh computer and hold down the
Command-Option (Apple-Alt) keys until you get the message “Are you sure you want to
rebuild the desktop?” then click on the “OK” button. More details on this procedure
should be given in your manual.

Step 4: CHECK FOR VIRUSES Check your Macintosh out with an anti-virus application such
as Symantec’s “Norton Anti-Virus” or Dr. Solomon’s “Virex”.

Step 5: CHECK SYSTEM SOFTWARE VERSION: Select “About This Macintosh” or “About
This Computer” from the ‘Apple’ menu. It will tell you your system software version here.

If Your System Version Is Recommended Action
B1-7.1, B1-7.1.1, B1-7.1.2 Upgrade the OS or install Open Transport 1.1.2.
B1-7.5, B1-7.5Px Upgrade using System 7.5 Update 2.0.
B1-7.5.1, B1-7.5.2, B1-7.5.3 Upgrade using System 7.5 Update 2.0.
B1-7.5.3 Update B1-2.0 You have the option of installing System 7.5.5 Update.
B1-7.5.3 Revision 2.x You have the option of installing System 7.5.5 Update.
B1-7.5.5 No action required.
B1-7.6 Upgrade using Mac OS 7.6.1 Update.
B1-7.6.1 No action required.
B1-8.0 Upgrade using Mac OS 8.1 Update.
B1-8.1 No action required.
B1-8.5 Upgrade using Mac OS 8.5.1 Update.

Step 6: APPLE HARD DISK DRIVER: Make sure you are using the correct version of the hard
disk driver for your Apple manufactured hard disks. To check which hard disk driver you
are using close all the open windows, click once on your hard disk icon (it should go dark)
and select “Get Info” from the ‘File’ menu. Make a note of what it says for “Where” and
contact Apple on 0990 127753 or see General Help Sheet No.2 “Hard Disk Drivers”.

Step 7: ADDITIONAL OR NON APPLE STORAGE DEVICES: If you have other storage
devices connected to your computer (hard disks, removal media, CD-ROM drives, CD-
ROM writers, etc) make sure the software drivers for these devices are SCSI Manager 4.3
compliant (4.3.1 for Mac OS 7.6 or higher). If you are unsure about this please direct your
questions towards the device manufacturer, software vendor or dealer first. Neither
Microsoft nor Apple can check device driver versions for hardware/software that was not
made/written by Apple. The versions you are running can be obtained as listed in step six.
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Step 8: CHECK INTERNET SOFTWARE VERSIONS: To do this you should run through
Internet Help Sheet No.1 “Connecting”.

Step 9: INTERNET EXPLORER VERSION: To check which version
you are using locate the icon for the Internet Explorer
application on your hard disk and then click on its icon once (it
should go dark). Now select “Get Info” from the ‘File’ menu.
You will get a window like the one to the right. Check what it
says for “Version” against the chart below.

Version Recommended Action
2.0b3, 2.0, 2.0.1 These are beta or early release versions. Microsoft

recommends using version 4.01 or if you have a
PowerPC based Macintosh version 4.5.

2.1 You are recommended to upgrade to version 4.01
or if you have a PowerPC based Macintosh
version 4.5.

3.0, 3.0b, 3.01 These are beta or early release versions. Microsoft recommends using
version 4.01 or if you have a PowerPC based Macintosh version 4.5.

3.01a You are recommended to upgrade to version 4.01 or if you have a PowerPC
based Macintosh version 4.5. Otherwise install the “IE 3.01r5 Updater” and
note that this product is not Year 2000 compliant.

4.0p1, 4.0p2, 4.0, 4.0a These are beta or early release versions. Microsoft recommends using
version 4.01 or if you have a PowerPC based Macintosh version 4.5.

4.01 If you have a PowerPC based Macintosh you are recommended to upgrade
to version 4.5. Otherwise install the “Internet Explorer 4.01 Updater”.

4.5 This is the latest version of Microsoft Internet Explorer

PART TWO: OPTIMUM APPLICATION/SYSTEM SETTINGS
The following steps give details of optimum settings for your system and Internet Explorer. If you
have been recommended to fix, install or update anything in “Part One: First Checks” your software
may already be corrupted and/or you are recommended to start afresh with a clean install of the
system software (see “Part Three: Installing/Updating Software” below). With this part (two) you
should check each step and if you have to do something you should then retry Internet Explorer
before proceeding to the next step to see if it has fixed the problem.

Step 1: POTENTIALLY UNSTABLE CONNECTION 1: Make sure you have the correct
modem/port set in your internet connection software (see Internet Help Sheets 2 to 10).

Step 2: POTENTIALLY UNSTABLE CONNECTION 2: Make sure your computer’s modem
is connected directly to a BT or equivalent wall socket. Try not to use adapters, splitters
and/or extension cables. If you plug a normal telephone into the same socket do you get a
nice clear line or are there cracks, pops and/or whistling noises on the line? Check the
quality of your line with your telephone company. They can usually check this for you.

Step 3: RAM DOUBLER/MEMORY ENHANCERS: Internet software in general does not like
memory enhancement utilities like RAM Doubler and RAM Charger. You should try
turning these off temporarily for Internet usage.
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Step 4: IE CACHE FILES: Explorer cache’s information to your hard disk. This information can
become corrupt. This is very likely if you experience a freeze or crash while starting the
application/browsing the web. If this happens always delete the cache files and run Disk
First Aid (see Part One: First Checks). Drag the cache files to the “Wastebasket” (make
sure the wastebasket goes dark before you let go of the mouse button). Select “Empty
Wastebasket” from the ‘Special’ menu. Then restart your Macintosh. Depending on which
version of IE you have your cache files will be found in slightly different places.

IF YOU HAVE IE 2.x: Double click on your hard disk icon, double click on the “System
Folder”, double click on the “Preferences” folder, double click on the “Explorer” folder,
double click on the “Cache” folder. Select “Select All” from the ‘Edit’ menu (all the items
in the folder should go dark). Now you can drag them to the wastebasket.

IF YOU HAVE IE 3.x: Double click on your hard disk icon, double click on the “System
Folder”, double click on the “Preferences” folder, double click on the “Explorer” folder,
double click on the “Explorer Cache” folder. Select “Select All” from the ‘Edit’ menu (all
the items in the folder should go dark). Now you can drag them to the wastebasket.

IF YOU HAVE IE 4.x: Double click on your hard disk icon, double click on the “System
Folder”, double click on the “Preferences” folder, double click on the “MS Internet
Cache” folder. Select “Select All” from the ‘Edit’ menu (all the items in the folder should
go dark). Now you can drag them to the wastebasket.

Note: If your Mac states that one or more of the items could not be deleted try selecting “Empty
Wastebasket” from the ‘Special’ menu while holding down the option key (alt). If the files
still cannot be deleted restart your Mac and check your hard disk with ‘Disk First Aid’.

Step 5: IE PLUG-INS: Explorer using plug-ins to help it utilise the different types of information
on the internet. These plug-ins can become corrupted or even conflict with each other.
This is very likely if you experience a freeze or crash while starting the
application/browsing the web. If this happens drag all the plug-ins to a ‘safe’ folder (i.e. a
folder you are not going to delete or the Internet Explorer folder itself. The plug-ins folder
can be found inside your Internet Explorer folder.

Step 6: MEMORY ALLOCATION: To increase the RAM
allocation locate the icon for the Internet Explorer
application (usually found inside the “Internet Explorer”
folder”). Click on the icon once (it should go dark). Now
select “Get Info” from the ‘File’ menu. You will get a
window like the one to the right. If you are using Mac OS
8.5 or later you will need to select “Memory” from the
‘Show’ pop-up menu first. Check what is listed in the
Memory Requirements section. Increasing the “Preferred
Size” will allocate more RAM to IE.

Note: As a good rule of thumb:
“Minimum Size = Suggested Size”
“Preferred Size = Suggested Size x 1.5”

Step 7: REMOVE EXPLORER PREFERENCES FOLDER: Double click on your hard disk
icon, double click on the “System Folder”, double click on the “Preferences” folder.
Locate the “Explorer” folder and drag it to your desktop. Do not delete this folder as it
contains ALL your Explorer settings including your favourites list. Restart the computer
and try IE again. If the application now works one of your settings files was corrupted.
You should delete the old “Explorer” folder and recreate your settings from scratch.
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Step 8: REDUCE SCREEN RESOLUTION AND COLOUR DEPTH: If your computer
supports this functionality this can usually be done via the “Monitors”, “Sound And
Monitors” or “Monitors And Sound” control panel.

Step 9: DISABLE INTERNET EXPLORER FEATURES

IF YOU HAVE IE 2.x: Launch IE. Select “Options” from the ‘Edit’ menu and then disable
the features on the following tabs:

PAGE&LINK: Disable the media settings (‘Show Pictures’, ‘Play Sounds’
and ‘Show’ Video). These settings are resource intensive
and may destabilise slower systems.

DISPLAY: Disable “Show Tool Bar” and “Show Icon Animation”.
Animation depends on Apple’s thread manager, which may
not function smoothly on older computers.

HOME/SEARCH PAGE: Click “Use None” to set the Home Page to none.

PROXY: Make sure the proxy settings, which are usually in the form
of Internet Protocol (IP) addresses, are correct.

ADVANCED: Empty the ‘History’ cache, empty the ‘Disk’ cache and
clear the ‘Support Multiple Connections’ check box.

In the main ‘Options’ window clear the ‘Use Internet Config’ settings check box.

IF YOU HAVE IE 3.x: Launch IE. Select “Preferences” from the ‘Edit’ menu and then
disable the features on the following tabs.

BROWSER DISPLAY: Disable “Show Icon Animation” and “Show Button Bar” in
the ‘Toolbar Settings’ section.

HOME/SEARCH PAGE: Click “Use None” to set the ‘Home Page’ to none.

ADVANCED: Click the “Empty Now” button in the ‘Cache’ section.

PROXY: If you are accessing the internet through a proxy server (a
server on a local area network that lets you connect to the
internet without using a modem), make sure that proxy is
enabled and that the proxy settings are correct.

IF YOU HAVE IE 4.x: Launch IE. Select “Preferences” from the ‘Edit’ menu and then
disable the features on the following tabs.

BROWSER DISPLAY: Disable “Show Icon Animation”, “Show Button Bar”,
“Show Favorites Bar” and “Show Explorer Bar” in the
‘Toolbar Settings’ section.

HOME/SEARCH PAGE: Click “Use None” to set the ‘Home Page’ to none.

SUBSCRIPTIONS: Set ‘Check For Changed Sites’ to “Manually”.

ADVANCED: Click the “Empty Now” button in the ‘Cache’ section. If
you have a direct connection to the internet check that
“Automatically Connect To The Internet If A Page Is Not
Cached” is checked (with an X in the box).

PROXY: If you are accessing the internet through a proxy server (a
server on a local area network that lets you connect to the
internet without using a modem), make sure that proxy is
enabled and that the proxy settings are correct.
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Step 10: ELIMINATE EXTENSION CONFLICT: An additional piece of software added to
your computer could be conflicting with Internet Explorer. To eliminate this possibility
use your “Extensions Manager” control panel to switch your extension set to your
recommended system software only and then restart your Macintosh.

IF YOU HAVE SYSTEM 7.1.2 or lower contact Apple on advice for troubleshooting your
extensions as you do not have an Extensions Manager control panel.

IF YOU HAVE SYSTEM 7.5.x select your System OS version from the ‘Sets’ menu.

IF YOU HAVE MAC OS 7.6 or later select your “Mac OS ALL” from the ‘Selected Set’
pop-up menu then click on the “Restart” button at the bottom.

Note: If you are testing Internet Explorer while connected to the internet at this step you will
also need to turn on any extensions required to access the internet (such as modem
software, Open Transport, ARA) so that you can actually connect for testing purposes.

Step 11: BAD HTML CODE OF WEB PAGE: Some web pages are not well written or contain
fancy features that might cause problems. The HTML code or the content of the page
could potentially crash IE. Check to see if IE is crashing when you visit particular
pages/sites only. If the crashes only occur at those pages/sites then the page/site could be
at fault or you may not have the right IE plug-in to utilise the facilities of that site. If the
page has been well designed it should have an information section detailing what you will
need to view the site correctly. If you have IE 3.0 or later you can switch off a lot of the
fancy features of an internet page and just view the plain text. You can toggle these
settings in the “Web Content” and “Java” settings within the IE ‘Preferences’ to see if this
is what might be causing the problem(s).

Step 12: DISK CACHE: Because IE writes information to the hard disk it can be very useful to
increase the Macintosh’s Disk Cache size. Open your “Memory” control panel and check
the setting for “Disk Cache”. As a good rule of thumb this should be 32Kb multiplied by
how much physical RAM you have installed (check the ‘available built in memory’ in the
Virtual Memory section of the “Memory” control panel if you don’t know).

For example: 16Mb RAM = 512Kb disk cache, 32Mb RAM = 1024Kb disk cache.

PART THREE: INSTALLING/UPDATING SOFTWARE
If all the above steps in parts one and two have been checked/performed then there are only a few
possibilities left and they would point to a more serious (software) corruption or the need for
installation and/or updating of software. Follow the steps below to eliminate these one by one. After
each step remember to use the Optimum Settings listed above in part two before testing Internet
Explorer out. In doing the following steps you will lose Internet Explorer’s “Favourites” settings so
make a note of them or back these up before continuing.

Step 1: IE CORRUPTED/REINSTALL: Fully remove IE and then reinstall. For information
about removing/reinstalling IE see Help Sheets 22 (removal) and 12 (re-install).

Step 2: APPLE INTERNET CONNECTION KIT CORRUPTED/REINSTALL: If you use
the Apple Internet Connection Kit it is possible that some of its software has become
corrupted. Remove and reinstall the AICK (see Internet Help Sheet No.4 “Install AICK”).

Step 3: SYSTEM SOFTWARE CORRUPTED: If IE is still not working properly “clean
install” your system software (contact Apple for instructions on how to do this), then
install your internet access software (see Internet Help Sheets 1 to 10) and then install
Internet Explorer (see Internet Help Sheet 12). Do not install anything else on the
computer until you have established that Internet Explorer is working correctly.
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Note: If IE is still not working go to step four below. If it is now working successfully you may
now add your other software and hardware items one at a time testing IE after each
installation. If IE stops working then it is 99% certain the last item you installed is causing
the problem. Contact the relevant manufacturer/vendor of this product for help.

Step 4: HARD DISK CORRUPTED: If IE is still not working properly “erase clean install” your
system software (contact Apple for instructions on how to do this), then install your
internet access software (see Internet Help Sheets 1 to 10) and then install Internet
Explorer (see Internet Help Sheet 12). Do not install anything else on the computer until
you have established that Internet Explorer is working correctly.

Note: If IE is still not working go to step five below. If it is now working you may now add your
other software and hardware items one at a time testing IE after each installation. If IE
stops working then it is 99% certain the last item you installed is causing the problem.
Contact the relevant manufacturer/vendor of this product for help.

Step 5: CONTACT MICROSOFT TECHNICAL SUPPORT: If Internet Explorer still fails to
work make a note of what steps you have followed and any (error) messages that have
appeared before contacting Microsoft technical support.

FREQUENTLY ASKED QUESTIONS
Q. I have heard that Microsoft Internet Explorer 4.5 can self-heal. Can I make use of this
feature in troubleshooting Internet Explorer?
A. Yes. You should run through Part One: First Checks at the beginning of this document and use
this quick test to make sure the IE application and its associated system files are working correctly:

Step 1: Start up your Macintosh with extensions off (hold down the shift key at startup until the
extensions off/disabled message appears).

Step 2: Then open the “Microsoft Internet 4.5” or “Internet Explorer 4.5” folder and locate the
“Help” folder inside the “Internet Explorer 4.5 Folder”.

Step 3: Inside this folder, double click on the “Welcome.htm” file. This should force, if necessary,
Internet Explorer to perform a “first run” installation and then open the application with
the welcome page to the html based help files.

Note: If this is successful it is most likely that you have an extension conflict or something has
become corrupted with your system software. Follow the appropriate steps in Parts Two
and Three to resolve these potential issues.

Note: If this is not successful it is most likely that some of your Microsoft Internet software has
a problem. You are recommended to completely remove Microsoft Internet 4.5 software
and then reinstall it. Internet Help Sheet 22 “Removing Internet Explorer” can help you
with this process.

Q. Where can I get anti-virus software from?
A. “Norton Anti-Virus” is available from Symantec (01628 592222 – www.symantec.com/uk).
“Virex” is available from Dr. Solomon’s Software (01296 318700 – www.drsolomons.com).

Q. My system software version doesn’t have B1 in front of it?
A. You are not using a British version of the system software. Contact Apple for more information
regarding this and how it will affect you and the software/updates you install.

Q. How can I tell if I have got an Apple manufactured hard disk?
A. Run Apple’s “Drive Setup”. This will list your SCSI/IDE devices. If your hard disk/hardware
device is listed as “Not Supported” then you have third party hardware. If you have an old 68K Mac
run “Apple HD SC Setup”. If it doesn’t find your SCSI hard disk you have third party hardware.
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Q. I have a third party hard disk/device, so what driver software should I use?
Q. Where can I get more information about hard disk drivers?
A. You are recommended to read and work through the advice given in General Help Sheet 2 “Hard
Disk Drivers for British/US System Software”.

Q. I have “call waiting’ for my telephone. Is this a problem?
A. It can be. When you are using the phone and get another call a beep will notify you that you have
another call. If you are connected to the internet at this time with a modem the beep can cause your
modem to lose the connection potentially crashing/freezing your Mac.

Q. I have RAM Doubler/RAM Charger. Why should I turn it off to use the internet?
A. A lot of internet software, especially world wide web browsers, cache (write) information to
RAM and to the hard disk. Having system enhancements like RAM Doubler might decrease
performance or even cause conflicts. Try using the internet with and without your enhancement
software and see which gives you the best performance/stability.

Q. I cannot find Internet Explorer’s cache files (as detailed in Part Two: Step 4)?
A. This will be the case if you changed the location of the “Cache” in the ‘Advanced’ section of the
Preferences for Internet Explorer. If you changed the location you will need to go the location you
set to delete the files.

Q. Where can I get more information on Internet Explorer plug-ins/add-ons?
A. You are recommended to read Internet Help Sheet 13 “Internet (Explorer) Extras”.

Q. Memory allocation (Part Two: Step 6) worked really well. Is it just for Internet Explorer?
A. No. The memory allocation tip can be used for any application installed on your Macintosh.

Q. I have disabled all the features you listed in Part Two: Step 9. Internet Explorer now
works fine but what do I do now?
A. Turn the features back on one at a time until IE stops working. The last feature you turned on is
the one that is causing the problem. Once you have found out which feature it is contact Microsoft
technical support for guidance.

Q. I am trying to view QuickTime (VR) movies on the internet but the web page reports that I
need QuickTime 3 (or later) and I already have this version installed. What’s wrong?
A. IE 4.5 only comes with version 1.1.1 of the QuickTime Plugin. To utilise the benefits of a later
version of the QuickTime Plugin you will need to install the plugin that comes with the latest
version of QuickTime.

Q. Where can I get the latest version of QuickTime from?
A. Go to www.apple.com/quicktime where you will be able to download it.

Q. How do I install the QuickTime plugin?
A. Run the QuickTime installer. If you do not have the latest version of QuickTime installed select
the “Easy Install” and click on the “Install” button. If you already have the latest version of
QuickTime installed select “Custom Install” and then click on the triangle to view the install
options. Select (put an X in the box) for QuickTime Plugin QuickTime folder and Plug-Ins folder.

Q. I have heard that Internet Explorer 4.5 integrates with Mac OS 8.5.x’s Sherlock feature
but I don’t appear to have a Sherlock button? What’s wrong?
A. Internet Explorer 4.5 will only integrate with Mac OS 8.5.x’s Sherlock if the Sherlock
application is located in its default install location which is Hard Disk > System Folder > Apple
Menu Items folder. If Sherlock is not in this location then IE 4.5 will not integrate with it. Please
note Sherlock’s name must not be changed from “Sherlock” and an alias of the application will not
work either. You should note that Apple do not recommend moving the Sherlock application as
updates to the Mac OS check the default install location as does Internet Explorer 4.5.
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Q. What is Internet Config?
A. Internet Config is a third party utility that helps keep all your internet configuration details in
one place. Microsoft recommends having this utility installed on your Macintosh if you are using
Microsoft Internet Explorer. IE (except IE 2.x) will install Internet Config for you unless you have
an Internet Config folder in the root directory of your hard disk. To check for this double click on
your hard disk icon and look for a folder called “Internet Config”. If you do not have one, the utility
will be installed for you. However, please note Microsoft applications will only check this
(recommended) location. It will not check the rest of your hard disk. Other applications or even the
Mac OS may install Internet Config elsewhere on your hard disk. Microsoft recommend checking
your hard disk and removing duplicate copies of Internet Config if you have them.

Q. I am using Internet Explorer 3.01/4.01. Can I put the “Microsoft Internet Applications”
folder somewhere else on my hard disk?
A. Microsoft recommends keeping your “Microsoft Internet Applications” at the root of your hard
disk especially if you’re installing any extras or updating Internet Explorer/Outlook Express. If you
have Microsoft Office 98 you are not recommended to put it in the “Microsoft Office 98” folder.

Q. Is there anywhere else I can get information on Microsoft Internet products?
A. If you have access to the World Wide Web (from another computer if necessary) then there is
always up to date information concerning Microsoft Internet Explorer at
www.microosft.com/ie/mac. This page also contains information on any updates or patches
available for Internet Explorer. There is a third-party information source on troubleshooting Internet
Explorer for Macintosh at www.macfixit.com/reports. Please note that this web site is in no way
affiliated with Microsoft but is certainly a recommended read.

PLEASE NOTE
• Microsoft strongly recommend that you backup any important data files before you attempt an

update install/restore of your system software especially any files you have in the “Documents”
folder (if you have one). To back up your files copy them to an external storage device such as a
second hard disk, SyQuest or Zip/Jaz drive. If you don’t have any of these you will need to
backup your data on to floppy disks. If you have files that are larger than 1.4Mb you will need a
third party compression application like “Stuffit Deluxe” (from Aladdin), “Disk Doubler Pro”
(from Symantec) or the shareware utilities Stuffit Lite, Compact Pro or Zip It.

• Where Pipex is mentioned as an ISP this is not a recommendation or endorsement by Microsoft
and the information is offered as a guideline only because Pipex is one of Apple’s recommended
ISPs in the UK. Microsoft cannot guarantee the quality of any ISP listed in this document.

• Where third party software is mentioned this is not a recommendation or endorsement by
Microsoft and the information is offered as a guideline only. Microsoft cannot guarantee the
workings of any of the third party products or Apple software mentioned.

• Microsoft can only support customers that have valid support with us. Just because you have a
Microsoft product or customer number it does not automatically entitle you to support. If you
are unsure about the validity of your support ring 0870 5010100 and quote your customer ID.

MICROSOFT UK
Telephone Support: 0870 5010100 (please have your customer number ready)

Fax: 0870 5020200 (please list your name, telephone number and customer number on the fax)
UK Faxback Information Service: 0870 5030100

UK support on line: www.microsoft.com/uk/support


